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AKVIS ARTIFACT REMOVER AI 2.0 | JPEG-COMPRESSED IMAGE RESTORATION

AKVIS Artifact Remover AI is a free image enhancement program intended to restore images with any compression ratio.
The software uses machine-learned algorithms to eliminate JPEG artifacts and defacements, reduce pixelization and clean up
edges. Get artifact-free images in a click!

JPEG artifacts are typically caused by aggressive image compression and appear as loss of sharpness, extra dots, seams,
blurry blocks, jagged or misfitting edges, smudged details, and color degradation.

AKVIS Artifact Remover AI is equally effective to get rid of all types of artifacts, including so-called mosquito noise,
pixelation, etc.

The program is a must for both home users and professionals.
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The software is available for free! To get a Free license key, enter your email address into the start window. Learn more.

To use the software for commercial purposes, you need a Business license. Compare Free vs. Business licenses.
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This AI-powered program provides three image adjustment modes depending on the quality of the processed photo: Low
Compression, High Compression, and High Compression with Noise.

 

AKVIS Artifact Remover AI is available as a standalone application and as a plugin filter. The plugin version is compatible
with AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, and other photo editors. Consult the AKVIS
plugins compatibility page.
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INSTALLATION

Follow the instructions to install AKVIS Artifact Remover AI on a computer with Windows OS:

Start the setup exe file.
Select your language and press the Install button.
To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

Press the Install button.
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The installation is in progress.

The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Artifact Remover AI.
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INSTALLATION

Follow the instructions to install AKVIS Artifact Remover AI on a Mac computer:

Open the dmg file:

- akvis-artifact-remover-app.dmg to install the Standalone version

- akvis-artifact-remover-plugin.dmg to install the Plugin into your image editor.

Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS Artifact Remover AI application or AKVIS Artifact Remover AI PlugIn inside.

 

To install the Standalone version, drag the AKVIS Artifact Remover AI app into the folder Applications (or any
other place you like).

To install the Plugin, drag the entire AKVIS Artifact Remover AI PlugIn folder into the Plug-Ins folder of your
graphic editor:

Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the Filter menu of your photo editor (in Photoshop: Filter ->
AKVIS -> Artifact Remover AI).

Run the standalone program by double-clicking on its icon in Finder.

You can also run the AKVIS program from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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PROGRAM ACTIVATION

AKVIS Artifact Remover AI is a free program that restores images with any compression ratio, eliminates JPEG artifacts,
pixelization, and noise.

 

When you run the unregistered version, the About the Program window appears with an invitation to activate it.

To get a free license key, enter your email address, activate both check-boxes (I accept the Privacy Policy and Subscribe to
AKVIS Newsletter), and click OK.

The license key will be sent to your email. You will be subscribed to the AKVIS Newsletter.

Attention!

The Free license is available exclusively for subscribers of AKVIS Newsletter. If you unsubscribe, your free license key
will be immediately disabled!
The Free license is a license for non-commercial, personal use only. To use the software in commercial purposes, you
need the Business license. Buy the Business version and use this license key to activate the software.

Enter your name and the license key (serial number) provided in the email.

Choose Direct connection to the activation server and click ACTIVATE. 
Your registration is completed!
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Attention! During the activation process your computer must be connected to Internet.

If your computer is not connected to Internet, use the Offline Activation method:

You will see a message that contains HardwareID (HWID) of your computer where you want to register the program. Send it
to us: activate@akvis.com.

You will get a license file for the program - ArtifactRemover.lic.

Save this file (do not open it!) in the AKVIS folder in Users’ Shared (Public) Documents:

Windows 7, Windows 8, Windows 10:

Users\Public\Documents\AKVIS;

Mac:

Users/Shared/AKVIS.
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WORKSPACE

AKVIS Artifact Remover AI can work independently as a standalone program as well as a plug-in to a photo editor.

Standalone is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program's shortcut.

On a Mac computer - launch the app from the Application folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select AKVIS –> Artifact Remover AI from the filters of your image editing program.

 

The AKVIS Artifact Remover AI workspace looks like this:

 

The left part of the program's window is taken by the Image Window with two tabs - Before and After. The Before tab
shows the original image, the After tab shows the result.

To switch between the tabs and compare the original and the resulting images, just click anywhere in the image.

You can select how Image Window and Before/After tabs will be shown by adjusting the Image View Modes in the
bottom part of the left panel.

 

In the upper part of the program's window you can see the Control Panel and the following controls:

The button  opens the home page of AKVIS Artifact Remover AI.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac.
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Right-click this button to display the list of recent files. You can change the number of recent documents in the
program's Preferences.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows,

⌘ +S  on Mac.

The button  (only in the standalone version) lets you print the image. The hot-keys are Ctrl+P  on Windows,

⌘ +P  on Mac.

The button  lets posting pictures from the program to the social networks.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.
The button  starts image processing of the entire image. The result is shown in the After tab.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  calls information about the program, license, and version.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box.

The button  opens a window showing the latest news about the program.

 

To the left of the main window there is the Toolbar.

The button  switches on/off the Preview Window.

The button  (only in the standalone version) activates the Crop tool which allows cutting off unwanted areas in the

image and reducing its size.

The button  activates the Hand tool which allows you scroll the image when it does not fit within the window at

the desired scale. Bring the cursor over the image, and while keeping the left mouse button pressed move in the desired
direction.
Double-clicking on the tool's icon  makes the image fit the window.

The button  activates the Zoom tool which changes the image's scale. To zoom in, click the image. To zoom out

left click with Alt  on the image. Press Z  to quickly access the tool.

Double-clicking on the tool's icon  makes the image scale to 100% (actual size).

 

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the
visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases.
When you move the slider to the left, the image scale decreases.

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the image with the left
mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed (Mac: ⌘ ) –
to the left/to the right, by keeping the Alt  key pressed (Mac: Option ) − scale the image. Right-click the scroll bar to
activate the quick navigation menu.

You can also change the image scale by entering a new coefficient into the scale field and pressing the button Enter

(Return  in Mac). The drop-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and

Ctrl+-  (⌘ +-  in Mac) to reduce the scale.
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Below the Navigator is the Settings Panel where you can adjust settings.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You
can choose where the hints will be shown or hide them in the program's Preferences.
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IMAGE VIEW MODES: BEFORE AND AFTER

At the bottom of the Toolbar of AKVIS Artifact Remover AI, there are three buttons which let you choose how the Image
Window will look like and arrange the Before and After tabs.

Click the first button to open a submenu that contains various options for viewing the original and processed images:

- The button  provides the standard image window mode with two tabs: Before and After.

- The buttons  and  divide the main window into two parts, vertically or horizontally, respectively. The

original and processed images become partially visible and the tabs are combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Before and After
parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as well. However, in

contrast to the previous option, the windows display the same fragment of the image before and after
processing.

Note: Use two windows side by side when you want to see and compare the original and processed versions of an
image fragment on one screen. If you would rather see the final image as a whole, you can choose the standard image
view mode.

The button  swaps the positions of the original image and result when displaying two windows.
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The 3rd button lets you choose the background color of the Image Window. Pressing , , or  changes the

background color to white, gray, or black, while clicking on  opens the Select Color dialog where you can choose a

color of your choice.
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USING THE PROGRAM

AKVIS Artifact Remover AI eliminates JPEG artifacts and noise and restores the quality of compressed images.

To enhance a photo, follow the instructions:

Step 1. Load an image into the software.

- If you work with the standalone version (RAW, JPEG, PNG, BMP, and TIFF file formats):

To open an image in the program, you can double-click in the empty workspace of Artifact Remover AI or drag the
image into the workspace, or press  in the Control Panel.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O

on Windows, ⌘ +O  on Mac.

Then call the AKVIS Artifact Remover AI plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> Artifact Remover AI;
in Adobe Photoshop: Filter –> AKVIS –> Artifact Remover AI;
in Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Artifact Remover AI;
in Corel Photo-Paint: Effects –> AKVIS –> Artifact Remover AI.

 

AKVIS Artifact Remover AI Window

Step 2. In the standalone program, before starting processing, you can use the Crop tool  to remove unwanted

portions of an image, straighten it, or change the aspect ratio. The tool settings will be shown in the Settings Panel.
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Crop Tool

Step 3. In the Settings Panel, select one of the AI-modes based on the quality of the processed photo: Low
Compression, High Compression, or High Compression with Noise.

If necessary, sharpen the edges of the processed image using the Sharpness parameter.

The quick result will be shown in the preview area. It is a square frame outlined with a dotted line ("marching ants").
Drag the square to the required position or draw it anew on any part of the image (double click with the left mouse) to
analyze the corresponding area. The preview window disappears after image processing starts and appears again when
any parameter is changed. To compare the converted sample with the original photo, click in the preview area.

Quick Preview

The size of the preview area is adjusted in the Preferences dialog box .

Step 4. Press  to start processing the entire image. To interrupt the process, click the Cancel button right to the

progress bar.
Step 5. Share your work by clicking on . It opens the list of the services where you can publish the image.

In the standalone version, you can also print your image with .
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Result

Step 6. Save the resulting image.

- When using the standalone:

Press . In the Save As dialog window, type a name for the file, select a format (TIFF, BMP, JPEG or PNG),

and choose a folder to save the file.

- When using the plug-in:

Press  to apply the result of the plugin. The AKVIS Artifact Remover AI plugin's window closes, and the

image appears in the photo editor workspace.

Open the save file dialog using the command File -> Save As in the graphics editor, enter a file name, choose a
file format and a folder to save the image.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This option defines the way the image is scaled in the Image Window.

- Fit to View: the image is completely visible in the window;
- 100%: the image doesn’t scale (generally, only a part of the image is visible).

Autorun Mode. When the check-box is enabled, any changes in the settings starts the image processing process
automatically.
Preview Window Size. Choose the desired value for the size of the quick preview area: from 200х200 px to 1000х1000
px.
Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files,
sorted by time, become visible by right mouse clicking on . Maximum: 30 files.

Hints. Choose how the hints will be shown:

- Under Settings Panel;
- Under Image Window;
- Hide.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible.

To save changes made in the Preferences window, press OK.

If you need, click the button Default to come back to the default settings.
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BATCH PROCESSING

AKVIS Artifact Remover AI supports the Batch Processing feature that lets you automatically process a series of photos
with similar compression defects.

If you use the plugin version in Photoshop, use this tutorial.

In the standalone program, follow the steps:

Step 1. Adjust the parameters. These settings will be applied to all photos in the folder.
Step 2. Click  in the Control Panel to open the Batch Processing dialog window.

Batch Processing Window in AKVIS Artifact Remover AI

In the Source Folder field choose the folder which contains the photos to be processed.

In the Target Folder choose the folder where the processed photos will be saved. You can check Include All
Subfolders to process all images in all subfolders of the selected folder (keeping the structure).

In the Save As list, select a file format.

Click  to call up a dialog box where you can configure the saving options for the selected file format.

In the File Name field, specify the names of the output files:

Source Name - the processed files will be saved with their original names. 
Add Suffix - the specified character set will be added to the original names. 
New Name - the names of all files will be replaced with the specified name with the addition of a sequence
number.

Step 3. Press Start to begin batch processing of the photos.

Batch Processing Series of Photos
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PRINT IMAGES IN AKVIS ARTIFACT REMOVER AI

In the standalone version of AKVIS Artifact Remover AI you can print the image. Press the button  to open the Print

options.

Print Options in AKVIS Artifact Remover AI

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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1. Low Quality 2. Medium Quality 3. High Quality

RECOVERY OF IMAGES WITH DIFFERENT COMPRESSION RATES

AKVIS Artifact Remover AI restores images with different compression rates. The program contains a trained neural network
to eliminate JPEG artifacts and distortions, reduce pixelation and clean up edges.

The software includes three image adjustment modes to choose from, depending on the quality of the processed photo: Low
Compression, High Compression, and High Compression with Noise. Compare the modes and apply the best one for
your image.

 

For example, let's take the same image saved in JPEG format with different quality.

 

1. Open a low quality (high compression) image in AKVIS Artifact Remover AI.

Select the Low Compression mode. The processing result will be shown in the preview window. It's obvious that the 1st
mode does not do very well for this image.

Switch to the High Compression mode. The processing result looks much better.
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If there is noise in the original image, then you can select High Compression with Noise. However, remember that along
with noise, the program may remove image details or change the colors on some areas.

 

2. Open a medium quality image.

Select the Low Compression mode. The preview window displays the processing result that looks very well.
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Switch to the High Compression mode which also produces an acceptable result.

 

3. Open the high quality image (saved with low compression).

Select Low Compression. The result is just great.
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Switch to the High Compression mode. On the image with the quality above medium, this mode gives not such a good
result.

 

If you do not know the quality of the image, you can choose the mode "by eye" or try to process it in each mode and choose
the best result.

After processing, if the image may not appear sharp enough, use the Sharpness parameter to restore the sharpness of the
edges. However, at higher values, you can recover unnecessary noise and artifacts.

Click  to process the entire image. Then you can save the result to disk, print or publish it on a social network.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
original quality of compressed images. The software is available free of charge. It is a must for both home users and
professionals. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture!
More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…
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AKVIS Magnifier AI — Change Image Size without Quality Loss

AKVIS Magnifier AI helps to resize images without loss in quality. Featuring neural networks based algorithms, Magnifier AI
enlarges digital pictures to super-high resolution and produces stunning wall-sized prints. More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
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includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

 

AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…
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AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches
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AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, and Maestro, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary
images into amazingly realistic aquarelle pieces of art. More…
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